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まず、ダイオード1個と抵抗１個からなるクリップ回路のシミュレーションを行なうことで、OrCAD PSpiceのシミュレーションの概要を学びます。OrCAD PSpiceでは様々なシミュレーションが可能ですが、ここでは、入力を時間と共に変化させ、出力がそれに伴ってどのように変化するかをシミュレーションする過渡解析（トランジェント解析）を行ないます。
１．１　起動とプロジェクトの新規作成
OrCAD PSpiceを使って回路をシミュレーションする場合、ネットリストというファイルをエディタで作成してもよいのですが、OrCAD Captureというソフトウェアで回路図を描いてシミュレーションを行なうのが一般的です。さっそく、OrCAD Captureを起動しまてみましょう。
①［スタート］→［すべてのプログラム］→［OrCAD 15.7 Demo］　→［OrCAD Capture CIS Demo］をクリックします。
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　　　　　　　　　　　　　　　図1.1　Captureの起動
　次に、プロジェクトの作成を行ないます。

②メニューバーの[File]→[New] →[Project]をクリックします。
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図1.2　Projectの作成

　New Projectダイアログボックスが表示されます。

③プロジェクト名を入力します。どのような名前を付けてのよいのですが、ここでは、「clip1」と入力することにします。

④[Analog or Mixed A/D] をクリックにより選択します。

⑤[Browse]ボタンをクリックすると保存場所を指定するためのダイアログボックスが表示されますので、プロジェクトを保存する場所を指定してください。

⑥[OK]ボタンをクリックします。
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図1.3　New Projectダイアログボックス

　Create PSpice Project ダイアログボックスが表示されます。

⑦[Create a blank project] をクリックにより選択します。

⑧[OK]ボタンをクリックします。
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図1.4　New Projectダイアログボックス

Clip1という新しいプロジェクトが生成され、Captureの画面が図1.5のようになります。
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図1.5　プロジェクト作成後のCaptureの画面

１．２　回路図の作成

１．２．１　ダイオードの配置
　まず、ダイオードを配置します。
①Place Partボタン[image: image5.png]


をクリックします。（または、メニューバーの[Place]→[Part]）
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図1.6　Place Partボタン

②[Add Library]ボタンをクリックします。
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図1.7　Place Partダイアログボックス
　
ダイオードは、breakout.olbというライブラリーに入っていますので、このライブラリーを追加します。
③breakout.olbをクリックします。

④[開く]ボタンをクリックします。
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図1.8　breakoutライブラリーの追加
ダイオードDbreakを選択します。
⑤Part Listの中のDbreakをクリックにより選択します。

⑥[OK]ボタンをクリックします。
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図1.9　ダイオードの選択
⑦クリックによりダイオードを回路図上に配置します。

[image: image10.png]File Edit View Place Macro PSpice Accessories Options Window Help

olslal 8| #=e] 2l TE Drea = el vl

S E(E]

A

5

- Bl =] 2l 2l2] [V 15w

|

Anelog or Mixed A/D

O Fie |8, Hirarchy|

[ €3 Desien Resourses
! ol den
Library

€3 outputs
€3 PSpice Resources

|21 =

2
Al

|=]e =

u

=|ololale] |%]

[i ftem selectec [ Part RefiD1 Part ValueDbreak 1

Sosle=100K

X400 V=170

V)





図1.10　ダイオードの配置

⑧[Esc]キーを押して配置モードを終了します。

（配置モードの終了は、マウスの右ボタンをクリック、[End Mode] を選択することによっても行えます）

⑨[R]キーを3回押して部品を回転し、下の図のようにアノードを下側にします。

　[R]キーを1回押すと反時計回りに９０度回転します。
（部品の回転は、マウスの右ボタンをクリックし、[Rotate] を選択することによっても行えます）
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図1.11　ダイオードの回転

　部品は、ドラッグにより移動できます。また、部品を配置した時または部品をクリックにより選択した時に表1.1の操作を行なうと、部品を回転または反転することができます。

表1.1　部品の回転反転操作

	機能
	キーによる操作
	マウスによる操作

	回転
	Rキー
	マウスの右ボタンをクリックし、[Rotate]をクリックする

	上下反転
	Vキー
	マウスの右ボタンをクリックし、[Mirror Vertically]をクリックする

	左右反転

	Hキー
	マウスの右ボタンをクリックし、[Millor Horizontally]をクリックする


　回路図を拡大表示したい時は、Zoom In ボタン[image: image12.png]


、縮小表示したい時はZoom Outボタン[image: image13.png]


を押します。
（または、マウスの右ボタンをクリックし、表示されるメニュー内でZoom InまたはZoom Outをクリックします。）
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図1.12　拡大表示と縮小表示 

１．２．２　抵抗の配置

　次に、抵抗を配置します。

①Place Partボタン[image: image15.png]


をクリックします。（または、メニューバーの[Place]→[Part]）

[image: image16.png]File Edit View Place Macro PSpice Accessories Options Window Help

T S R i e |

e e [

= [=] 2les[ )2 v T[] |w

3 Fie [' oty

) £3 Desien Resources

T =) ¥clipl.dsn
E B SCHEMATICT

3 Desien Gache
3 Library
€3 Outputs

3 PSpice Resources g
o)
I
iy
Ny
x|
o
-|| ©f
| ¥l
1 em selected [Sccle=2008 X170 V=140, A|





図1.13　Place Partボタン

②[Add Library]ボタンをクリックします。
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図1.14　Place Partダイアログボックス

　抵抗は、analog.olbというライブラリーに入っていますので、このライブラリーを追加します。
③analog.olbをクリックします。

④[開く]ボタンをクリックします。
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図1.15　analogライブラリーの追加

　抵抗Rを選択します。

⑤Part Listの中のRをクリックにより選択します。

⑥[OK]ボタンをクリックします。
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図1.16　抵抗の選択
⑦クリックにより抵抗を回路図上に配置します。

⑧[Esc]キーを押して配置モードを終了します。

（または、マウスの右ボタンをクリックし、[End Mode] を選択します。）
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図1.17　抵抗の配置

１．２．３　交流電圧源の配置
　次に、交流電圧源を配置します。

①Place Partボタン[image: image21.png]


をクリックします。（または、メニューバーの[Place]→[Part]）
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図1.18　Place Partボタン

②[Add Library]ボタンをクリックします。
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図1.19　Place Partダイアログボックス

　交流電圧源は、source.olbというライブラリーに入っていますので、このライブラリーを追加します。

③source.olbをクリックします。

④[開く]ボタンをクリックします。
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図1.20　sourceライブラリーの追加

　交流電圧源VSINを選択します。

⑤Part Listの中のVSINをクリックにより選択します。

⑥[OK]ボタンをクリックします。
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図1.21　抵抗の選択
⑦クリックにより交流電圧源を回路図上に配置します。

⑧[Esc]キーを押して配置モードを終了します。

（または、マウスの右ボタンをクリックし、[End Mode] を選択します。）
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図1.22　交流電圧源の配置

１．２．４　グランドの配置
　次に、グランドを配置します。

①Place groundボタン[image: image27.png]


をクリックします。（または、メニューバーの[Place]→[Ground]）
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図1.23　Groundボタン

②0/SOURCEをクリックにより選択します。

③[OK]ボタンをクリックします。
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図1.24　グランドの選択

④クリックによりグランドを回路図上に配置します。

⑤[Esc]キーを押して配置モードを終了します。

（または、マウスの右ボタンをクリックし、[End Mode] を選択します。）
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図1.25　交流電圧源の配置

１．２．５　配線
①Place Wireボタン[image: image31.png]


をクリックします。（または、メニューバーの[Place]→[Wire]）
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図1.26　Place Wireボタン

　交流電圧源と抵抗を接続します。

②交流電圧源の上の接続点でクリックします。

③抵抗の左の接続点でクリックします。
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図1.27　交流電圧源と抵抗の接続

　抵抗とダイオードを接続します。

④抵抗の右の接続点でクリックします。

⑤ダイオードの上の接続点でクリックします。
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　　　　　　　　　　　　　図1.28　抵抗とダイオードの接続

　ダイオードとグランドを接続します。
⑥ダイオードの下の接続点でクリックします。
⑦グランドの接続点でクリックします。
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図1.29　ダイオードとグランドの接続

交流電圧源とグランドを接続します。

⑧交流電圧源の下の接続点でクリックします。

⑨ダイオードとグランドをつないだ配線の上でクリックします。
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図1.30　交流電圧源とグランドの接続

１．２．６　部品の値の設定
　交流電圧源のオフセット電圧VOFF=0V、振幅VAMPL=５V、周波数FREQ=50Hzに設定します。まず、オフセット電圧VOFFから設定していきます。オフセット電圧とは、交流電圧源の直流成分です。ここでは、0Vに設定します。

①交流電圧源の横のVOFFという文字をダブルクリックします。
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図1.31　交流電圧源の値の設定 
　パーツの値を設定するためのダイアログボックスが表示されます。
②Valueに0と入力します。

③[OK]ボタンをクリックします。

[image: image38.png]Name: VOFF

Value o

Display Format
€ DoNot Display

€ Value Orly
 Name andViaue
€ Name Only

€ BothifValue Exists

[

Font
Aria 7 (defaul)

Change.

Color

Rotation
G
C 0

Cancel

€ 180
c

Help





図1.32　VOFFの設定
　振幅を５Vに設定します。

④VAMPLをダブルクリックします。

　パーツの値を設定するためのダイアログボックスが表示されます。

⑤Valueに５と入力します。

⑥[OK]ボタンをクリックします。

　周波数を50Hzに設定します。

⑦FREQをダブルクリックします。

　パーツの値を設定するためのダイアログボックスが表示されます。

⑧Valueに50と入力します。

⑨[OK]ボタンをクリックします。

　図1.33のように各値が回路図上に表示されていれば交流電圧源の設定は完了です。
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図1.33　交流電圧源の値の設定終了

１．３　シミュレーション
1.3.1　シミュレーション設定

　PSPiceの解析手法には何通りかありますが、ここでは、過渡解析を行なうための設定を行ないます。1つの回路に対して複数のシミュレーションを行なうことができるため、各シミュレーションに名前をつける必要があります。
①New Simulation Profile ボタン[image: image40.png]


をクリックします。
（または、メニューバーの[PSpice]→[New Simulation Profile]）
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図1.34　New Simulation Profile ボタン

　New Simulation ダイアログボックスが表示されます。

②シミュレーション名を入力します。どのような名前をつけてもよいのですが、ここでは、「tran」と入力することにします。

③[Create]ボタンをクリックします。
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図1.35　New Simulation ダイアログボックス

　Simulation Settingsダイアログボックスが表示されます。
④Run to timeに100ｍ　と入力します。

⑤Maximum step sizeに0.1ｍ　と入力します。

⑥[OK]ボタンをクリックします。
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　　　　　　　　　図1.36　Simulation Settingsダイアログボックス

　Run to timeは、シミュレーション時間です。あまり大きく設定すると解析時間が長くなります。Maximum step sizeは、シミュレーションに利用される内部時間間隔の最大値で、出力波形が滑らかでない場合に指定します。小さく設定しすぎると、解析時間が長くなります。

１．３．２　波形表示ポイントの指定
　波形を表示させたい場所を指定します。今回は、入力電圧と出力電圧を表示しましょう。

①Voltage/Level Markerボタン[image: image44.png]


をクリックします。

②交流電圧源と抵抗を接続している配線上でクリックします。

③抵抗とダイオードを接続している配線上でクリックします。
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図1.37　波形表示ポイントの指定 

１．３．３　シミュレーションの実行

　シミュレーションを実行しましょう。

①Run PSpice ボタン[image: image46.png]) |



をクリックします。
（または、メニューバーの[PSpice]→[Run]）
[image: image47.png]File Edit View Place Macro PSpice Accessories Options Window Help

o 1= =1 = 1 T e 1= R = e = A
SCHEMATIC =l Wrelmiver e R A e\

3 Desien Gache
3 Library VOFF =0

=-C2 Outputs VAMPL =5
! Helip-pspioefiles¥] FREQ =50

|=]e =

ololsl %]

[0 ftems selected [Seak=2008 %0 Y=0





図1.38　シミュレーションの実行

　図1.39のようにシミュレーション結果が表示されます。
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図1.39　シミュレーション結果
１．４　シミュレーション結果の加工

１．４．１　グラフの追加
　入力波形と出力波形をそれぞれ別のグラフに表示してみましょう。

①メニューバーの[Plot]→[Add Plot to Window]をクリックします。
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図1.40　グラフの追加

②移動したいグラフの凡例をクリックにより指定します。
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図1.41　移動したいグラフの指定

③[Ctrl]キーを押した状態で、[X]キーを押し、選択しているグラフを消去します。

（または、メニューバーの[Edit]→[Delete]）
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図1.42　移動したいグラフの削除

④貼り付けたいグラフ領域をクリックにより指定します。
⑤[Ctrl]キーを押した状態で、[V]キーを押し選択し、今削除したグラフを貼り付けます。

（または、メニューバーの[Edit]→[Past]）
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図1.43　移動したいグラフの貼り付け

１．４．２　シミュレーション結果のワープロ等への貼り付け
　シミュレーション結果のグラフは、画像データとしてワープロ等に貼り付けることができます。

①メニューバーの[Windows]→[Copy to Clipboard]をクリックします。

②ダイアログボックスが表示されますので、[OK]をクリックします。

③ワープロ等のソフトに移動し、[Ctrl]キーを押した状態で、[V]キーを押し貼り付けます。
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図1.44　シミュレーション結果のワープロ等へのコピー

１．４．３　軸の設定変更

　X軸の設定を変更し、60msから80msの部分を表示するようにします。
①メニューバーの[Plot]→[Axis Settings]をクリックします。
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図1.45　軸の設定変更 

　Axis Settingダイアログボックスが表示されます。

②User Definedをクリックにより選択します。
③テキストボックスにX軸の範囲を入力します。今回は、60ms、80ｍsと入力します。

④[OK]ボタンをクリックします。
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図1.46　Axis Settingダイアログボックス

図1.47のようにX軸の設定が変更され、60msから80msの部分のみが表示されるようになります。
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図1.47　X軸の設定変更終了 

１．５　Captureの終了とプロジェクトの読み込み

　いったんプログラムを終了し、再度プロジェクトを読み込んでみましょう。

１．５．１　プログラムの終了

　シミュレーション結果を表示しているプログラムを終了しましょう。

①メニューバーの[File]→[Exit]をクリックするします。
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図1.48　シミュレーション結果を表示しているプログラムの終了

　回路図入力のソフトCaptureを終了しましょう。

②メニューバーの[File]→[Exit]をクリックします。
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図1.49　Captureの終了

１．５．２　プロジェクトの読み込み

　再びCaptureを起動しましょう。
①［スタート］→［すべてのプログラム］→［OrCAD 15.7 Demo］→［OrCAD Capture CIS Demo］をクリックします。
　Captureのウインドウが表示されたら、

②メニューバーの[File]→[Open]→[Project]をクリックします。
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図1.50　プロジェクトのオープン

Open　Projectダイアログボックスが表示されますので、

②オブジェクトを選択します。今回は、先ほど作成したClip1.opjを選択しましょう。

③[開く]ボタンをクリックしましょう。
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図1.51　Open Projectダイアログボックス

　プロジェクトを開いても回路図が表示されない場合があります。このような場合は、以下の手順で回路図を表示させましょう。

④[プロジェクト名.dsn]をダブルクリックする。

⑤[SCHEMATIC1]をダブルクリックする。

⑥[PAGE1]をダブルクリックする。
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図1.52　回路図を表示させる


　この章では、最も基本的な半導体素子であるダイオードの動作原理について学ぶと共に、その静特性をシミュレーションにより確認します。また、ダイオードを用いた波形整形回路と整流回路のシミュレーションを行ないます。
２．１　ダイオードの動作原理
２．１．１　ｐ形半導体とｎ形半導体

　半導体とは、電気を通しやすい「導体」と電気を通さない「絶縁体」との中間の性質を持つ物質です。代表的なものに電子素子の材料として最も多く利用されているシリコン（Si）があります。シリコンは、Ⅳ族の元素で、4個の最外郭電子（最も外側の軌道に存在する電子）を持っています。これを模式図で表したものが図1.1です。

　　　　　　　　　　　　　　　　図1.1　シリコン原子

　シリコンでは、最外郭電子が８個の状態が最も安定な状態であるため、図1.2のように周辺の原子と最外郭電子を互に共有して結晶を構成します。







　　　　　　　　　　　　　　　　図1.2　シリコンの結晶
　シリコン結晶に、外部から熱や光などのエネルギーが加わると、図1.3のように最外郭電子が原子核の束縛から離れ、半導体内を自由に移動するようになります。このように、物質内を自由に移動できる電子のことを、自由電子といいます。シリコンでは、常温程度のエネルギーでこのような現象が起こります。また、最外郭電子が抜けた孔は、正の電荷を持ちます。この孔のことを、正孔またはホールといいます。正孔は、発生した場所に留まっておらず、「椅子取りゲーム」のように、順々に抜けた場所を移動することで電荷を伝えます。電荷を伝える働きのある自由電子と正孔のことをキャリアといいます。純粋なシリコン結晶では、自由電子と正孔の数は同じになります。




　　　　　　　　　　　　　　　　図1.3　自由電子と正孔
　純粋なシリコンでは自由電子の数と正孔の数が同じですが、実際に電子素子に使われるのは、シリコンに微量の不純物を加え、自由電子と正孔の数を調整した不純物半導体と呼ばれる半導体です。なお、不純物を加えない純粋な半導体のことを真性半導体またはi形半導体と呼ぶこともあります。
　図1.4はリンPなどⅤ族の元素を不純物として微量加えたｎ形半導体の模式図です。Ⅴ族の不純物はであるリンの最外殻電子は5個なので、リンの周りの最外殻電子は9個になります。しかし、８個が安定な状態であるため、1個の最外殻電子は、わずかなエネルギーで自由電子になります。このとき、正孔の発生を伴わないので、半導体内の自由電子の数が正孔の数より多くなり、電気伝導のほとんどが電子により行われるようになります。このように電気伝導が電子、すなわち負（Negative）の電荷で行われることから、Ⅴ族の元素を不純物として加えた半導体をｎ形半導体と呼びます。
　図1.5はホウ素などⅢ族の元素を不純物として微量加えたｐ形半導体の模式図です。Ⅲ族の不純物であるホウ素の最外殻電子は３個なので、ホウ素の周りの最外殻電子は７個になります。しかし、８個が安定な状態であるため、この場所は、電子を受け入れることが可能な正孔になります。このとき、自由電子の発生を伴わないので、半導体内の正孔の数が自由電子の数より多くなり、電気伝導のほとんどが正孔により行われるようになります。このように電気伝導がが正孔、すなわち正（Positive）の電荷で行われることから、Ⅲ族の元素を不純物として加えた半導体をｐ形半導体と呼びます。




　　　　　図1.4　ｎ形半導体　　　　　　　　　　　図1.5　p形半導体

　今説明したように、不純物半導体であるｎ形半導体とｐ形半導体では、電子と正孔の数が違いました。このとき多いほうを多数キャリア、少ないほうを少数キャリアといいます。ｎ形半導体では、多数キャリアが電子、少数キャリアが正孔になります。ｐ形半導体では多数キャリアが正孔、少数キャリアが電子になります。また、ｎ形半導体を作成するときに加えた不純物のことを、電子を供給すると言う意味でドナー、ｐ形半導体を作成するときに加えた不純物のことを、電子を受け入れるという意味でアクセプタといいます。以上を表2.1にまとめます。
　　　　　　　　　　　　　　　　表2.1　キャリアと不純物
	
	多数キャリア
	少数キャリア
	加える不純物

	ｉ形半導体
	電子と正孔の数は同じ
	なし

	ｎ形半導体
	電子
	正孔
	ドナー（Ⅴ族）P、As、

	ｐ形半導体
	正孔
	電子
	アクセプタ（Ⅲ族）B、Ga


２．１．２　ｐｎ接合

　半導体素子を考える上で、最も重要な構造がpn接合です。図2.6のように、ｐｎ接合とは、ｐ形半導体とｎ形半導体がある面を境にして合わさった構造です。。



　　　　　　　　　　　　　　　　　　


　　　　　　　　　　　　　　　　　　図2.6　ｐｎ接合
　物質は、一般的に均一濃度になろうとする性質を持っています。この性質のことを拡散といいます。自由電子の数はｎ形半導体の方がｐ形半導体より多いので、ｎ形半導体からｐ形半導体へ拡散していきます。また、正孔はｐ形半導体の方がｎ形半導体より多いので、ｐ形半導体からｎ形半導体へ拡散していきます。ｐ形半導体に移動した自由電子は、ｐ形半導体で多数を占める正孔と再結合し消滅します。また、ｎ形半導体に移動した正孔は、ｎ形半導体で多数を占める自由電子と再結合し消滅します。このため、境界付近には、キャリアが存在しない部分ができます。これを空乏層といいます。図2.7は、これを模式化した図です。







　　　　　　　　　　　　　　図2.7　キャリアの拡散と空乏層
　空乏層の幅ですが、拡散によりどんどん大きくなるように思うかもしれませんが、実は自由電子と正孔の移動により、ｐ形半導体の領域は負にｎ形半導体の領域は正に帯電し、空乏層にキャリアの移動を抑制する方向の電界が発生します。そして、キャリアが拡散しようとする力と、この力がちょうどつり合ったところで、キャリアの拡散はとまります。この時の電位差を電位障壁と呼びます。
２．１．３　ダイオード

　ｐｎ接合をそのまま利用した電子素子がダイオード（Diode）です。図2.8はダイオード内部構造と回路記号です。ダイオードは2つの端子を持っており、ｐ形半導体側の端子をアノード、ｎ形半導体側の端子をカソードと呼びます。アノード端子をA、カソード端子をKで表す場合もあります。




（ａ）内部構造



（ｂ）回路記号

　　　　　　　　　　　図2.8　ダイオードの内部構造と回路記号
　図2.9のようにダイオードのアノード端子に正、カソード端子に負の電圧を加えると、電位障壁が低くなりキャリアの移動がおこり、電流が流れはじめます。この場合の電圧VFを順方向電圧、この時に流れる電流IFを順方向電流といいます。また、この時のダイオードの内部抵抗RFを順方向抵抗と言います。







　　　　　　　　　　　　　　　　図2.9　順方向
　　　　　　　　　　　　　　　
　反対に、図2.10のようにダイオードのアノード端子に負、カソード端子に正の電圧を加えると、電位障壁が大きくなりキャリアの移動はますます困難になり、ほとんど電流は流れません。この場合の電圧VRを逆方向電圧、この時ほとんど電流は流れませんが少数キャリアによって極微小流れる電流IRを逆方向電流といいます。また、この時のダイオードの内部抵抗RRを逆方向抵抗と言います。



　　　　　　　　　　　　　　　　図2.10　順方向
　内部抵抗表2.2に順方向・逆方向電圧を印加した時のダイオードを流れる電流と内部抵抗をまとめたものです。

　　　　　　　　　　　　　　表2.2　ダイオードを流れる電流と内部抵抗

	電圧
	電流
	内部抵抗

	順方向電圧（アノード端子　正、カソード端子　負）
	よく流れる
	小さい

	逆方向電圧（アノード端子　負、カソード端子　正）
	ほとんど流れない
	大きい


　ダイオードはアノードからカソードの向きに電流をよく流しますが、カソードからアノードの向きには、電流をほとんど流しません。このように、一方向しか電流を流さない性質を整流作用と言います。
　また、ダイオードは、順方向電圧を印加すると内部抵抗が小さくなり、逆方向電圧を印加すると内部抵抗が大きくなることから印加電圧よってオン、オフするスイッチと考えることもできます。これを、ダイオードのスイッチング作用と言います。

　図2.11は最も簡単なダイオードのモデルです。これを、ダイオードのスイッチモデルといいます。ダイオードを含んだ回路の大まかな動作を考える時にこのモデルを用います。


　　　　　　　　　　　順方向　オン　　　　　　　逆方向　オフ
図2.11　ダイオードのスイッチモデル
　実際のダイオードでは、ダイオードをオンするために約0.7Vの電圧が必要であり、そのためオン状態のときにアノードとカソードの間に約0.7Vの電位差が常に発生します。図2.12は、この電圧を考慮したダイオードのモデルです。このモデルもダイオードを含んだ回路の動作を考える時に良く使われます。

　　　　　　　　　　　順方向　オン　　　　　　　逆方向　オフ

図2.12　ダイオードのオフセット付きスイッチモデル
　また、ダイオードがオンのときに抵抗成分がありますので、これを考慮したモデルが図2.13です。


　　　　　　　　　　　順方向　オン　　　　　　　逆方向　オフ

図2.13　ダイオードのオフセットとオン抵抗付きスイッチモデル

　回路シミュレータPSpiceでは、ダイオードをもっと複雑なモデルで表してシミュレーションを行っていますが、ここでは省略します。
２．２　ダイオードの静特性

　ダイオードに付加を接続しない状態、つまりダイオード単体の電圧-電流特性を静特性といいます。１章では、時間と共に入力が変化し、そのときの出力の様子を解析する過渡解析というシミュレーションを行ないました。ここでは、直流的な性質を調べるDC解析を行ないます。
２．２．１　回路図の作成
　図2.14の回路が、ダイオードの静特性をシミュレーションするための回路図です。ダイオードとこれに印加する直流電圧源のみのシンプルな回路です。なお、 V1の直流電圧源は、sourceというライブラリー内のVDCという部品です。
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図2.14　ダイオードの静特性のシミュレーション用の回路

２．２．２　波形表示ポイントの指定

　図2.15のように波形表示ポイントを設定します。なお、電流を表示させるためには、
①Current Markerボタン[image: image65.png]


をクリックします。

②ダイオードの上端でクリックします。Current Markerは接続端子にしか付けることができません。
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図2.15　波形表示ポイントの設定

２．２．３　シミュレーション
　New Simulation Profile ボタン[image: image67.png]


をクリックし、シミュレーション名をつけた後、図2.16のようにシミュレーションの設定を行ないます。
①Analysis typeでDC Sweepを設定します。

②Voltage source Name で電圧を変化させたい電圧源を指定します。

③Start valueとEnd valeで変化させる電圧の範囲を指定します。ここでは、-1と1とします。

④Increment で電圧の増分を指定します。ここでは、0.01とします。

⑤[OK]ボタンをクリックします。
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図2.16　 DC解析のシミュレーション設定

　Run PSpice ボタン[image: image69.png]) |



をクリックすると、図2.17の結果が表示されます。
　これより、ダイオードは、負の電圧を印加した時は電流が流れず、正の電圧が0.7Vを越えた付近から急激に電流が流れ出すことが分かります。
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図2.17　 DC解析のシミュレーション設定

２．３　波形整形回路

　ある基準電圧より高い部分や低い部分をカットしたり取り出したりする回路をクリップ回路（クリッパ）といいます。ダイオードと抵抗を使った4種類のクリップ回路のシミュレーションを示します。

２．３．１　ダイオード並列形クリップ回路（正の電圧をカット）

　この回路は、第1章でシミュレーションした回路です。入力電圧が負のとき、ダイオードに逆方向電圧が加わるので、ダイオードはオフ状態になり交流電圧源の電圧がそのまま出力されます。入力電圧が正のとき、ダイオードに順方向電圧が加わり、入力電圧が0.7Vを超えるとダイオードがオン状態になり出力は0.7Vになります。つまり、この回路は0.7Vより高い電圧をカットすることができます。
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図2.18　ダイオード並列形クリップ回路（正の電圧をカット）
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図2.19　図2.18の回路のシミュレーション設定 
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図2.20　図2.18の回路のシミュレーション結果
２．３．２　ダイオード並列形クリップ回路（負の電圧をカット）

　入力電圧が正のとき、ダイオードに逆方向電圧が加わるので、ダイオードはオフ状態になり交流電圧源の電圧がそのまま出力されます。入力電圧が負のとき、ダイオードに順方向電圧が加わり、入力電圧が-0.7Vより低くなるとダイオードがオン状態になり出力は-0.7Vになります。つまり、この回路は-0.7Vより低い電圧をカットすることができます。
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図2.21　ダイオード直列形クリップ回路（正の電圧をカット）の回路図
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図2.22　図2.11の回路のシミュレーション設定
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図2.23　図2.11の回路のシミュレーション結果 
２．３．３　ダイオード直列形クリップ回路（負の電圧をカット）

　入力電圧が正のとき、ダイオードに順方向電圧が加わるので、ダイオードはオン状態になり交流電圧源の電圧よりダイオードの順方向電圧0.7Vだけ低い電圧が出力されます。また、入力電圧が負になるダイオードがオフ状態になり常に0Vを出力します。つまり、この回路は0Vより低い電圧をカットすることができます。
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図2.24　ダイオード直列形クリップ回路（正の電圧をカット）の回路図
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図2.25　図2.14の回路のシミュレーション設定
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図2.26　図2.14の回路のシミュレーション結果

２．３．４　ダイオード直列形クリップ回路（正の電圧をカット）

　入力電圧が負のときは、ダイオードがオン状態なので交流電圧源の電圧より、ダイオードの順方向電圧0.7Vだけ高い電圧が出力されます。また、入力電圧が正になるダイオードがオフ状態になり常に0Vを出力します。つまり、この回路は0Vより高い電圧をカットすることができます。
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図2.27　ダイオード直列形クリップ回路（負の電圧をカット）の回路図
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図2.28　図2.17の回路のシミュレーション設定
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図2.29　図2.17の回路のシミュレーション結果

２．４　整流回路

　交流電圧から直流電圧を生成する回路を整流回路といいます。ここでは、半波整流回路とブリッジ形全波整流回路の２つのシミュレーションを示します。
２．４．１　半波整流回路
　正の電圧が印加されると、ダイオードがオン状態となりコンデンサに電荷が充電されます。入力電圧がコンデンサの電圧より下がると、ダイオードはオフ状態となり、その間はコンデンサから電流が供給され抵抗R1に流れます。
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図2.30　半波整流回路の回路図
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図2.31　図2.20の回路のシミュレーション設定
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図2.32　図2.20の回路のシミュレーション結果
２．４．２　ブリッジ形全波整流回路
　正の電圧が印加されると、ダイオードがD1とD2がオン状態となりコンデンサは右側プラス、左側マイナスに充電されます。負の電圧が印加されると、D3とD4がオン状態となり、先ほどと同様、コンデンサは右側プラス、左側マイナスに充電されます。半波整流回路と比べて、半周期ごとに充電が行なわれるためリップル（揺れ）が少ないことが分かります。出力は、コンデンサ両端から取り出します。2点間の電圧を表示させるには、Voltage Differential Markerボタン[image: image86.png]


をクリックし、回路図上の2点をクリックにより指定します。
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図2.33　ブリッジ形全波整流回路の回路図
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図2.34　図2.23の回路のシミュレーション設定
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図2.35　図2.23の回路のシミュレーション結果


　トランジスタには、バイポーラトランジスタとユニポーラトランジスタ（電界効果トランジスタ）の2種類がありますが、この章では、バイポーラトランジスタについて学びます。まず、パイポーラトランジスタの動作原理を学び、その静特性をシミュレーションにより確認します。次に、バイポーラトランジスタを用いた増幅回路のシミュレーションを行ないます。

３．１　バイポーラトランジスタの動作原理
　バイポーラトランジスタも、npnトランジスタとpnpトランジスタの2種類があります。図3.1は、それぞれのバイポーラトランジスタの内部構造と回路記号です。バイポーラトランジスタは、エミッタ（emitter）、コレクタ（collector）、ベース（base）と呼ばれる３つの端子を持っています。エミッタ端子をE、コレクタ端子をC、ベース端子をBで表す場合もあります。トランジスタの３つの端子ですが、「えくぼ（ECB）」と覚えると簡単に記憶できると思います。エミッタはキャリアを放出（emit）することから、コレクタはキャリアを収集（collect)することからこう名づけられました。ベースは土台（base）という意味です。初期のトランジスタの点接触形トランジスタでは、土台の半導体に金属線を二本立てた構造いたことからこう呼ばれています。
　図3.1の内部構造を見ると、ベースに対して、エミッタとコレクタは対象に見えますが、実際の素子ではエミッタ領域の不純物濃度の方が、コレクタ領域の不純物濃度より高く、コレクタとエミッタを入れ替えて使用すると十分な特性は得られません。また、ベースはコレクタやエミッタの領域に比べて非常に薄く作られています。







　　　　　　　　　　　　　　　　　

　　　　　　　　　　図3.1　バイポーラトランジスタの内部構造と回路記号

　図3.2はバイポーラトランジスタの動作原理を表した図です。バイポーラトランジスタは、コレクタ・ベース間に逆方向電圧を、ベース・エミッタ間に順方向電圧を印加して使用します。コレクタ・ベース間に逆方向電圧が印加されているので、コレクタとベースの境界付近に空乏層が形成されます。このため、単純に考えるとコレクタ電流ICは流れないような感じをうけます。しかし、ベース・エミッタ間に順方向電圧を印加しているので大量のキャリアがベース領域に流れ込みます。流れ込んできたキャリアは、ベース領域が薄く作られているためベース領域で再結合せずに空乏層に入り込みます。空乏層に入ったキャリアは空乏層にかかっている電界に引っ張られコレクタ領域に達しコレクタ電流ICになります。また、ベース領域で再結合したキャリアはベース電流IBになります。再結合するキャリアの割合がほぼ一定であることから、コレクタ電流ICとベース電流IBはほぼ比例します。









　　　                  図3.2　pnpトランジスタの動作原理

３．２　バイポーラトランジスタの静特性と接地方式
3.2.1　接地方式

　トランジスタ単体の特性を静特性といい、付加を接続した状態での特性を動特性といいます。トランジスタは、３つの端子を持っていますが、使用するときは入力側2端子、出力側2端子の合計4端子の入出力端子が必要になります。そのため、1つの端子を入力側と出力側で共通に使用する必要があります。これを、接地といいます。接地の方式には、図3.2のようなエミッタ接地、コレクタ接地、ベース接地の３方式があります。このうち、エミッタ接地は、増幅作用が最も大きいのでよく用いられます。ここでも、エミッタ接地の静特性について説明します。エミッタ接地の場合の代表的な静特性には、入力特性、電流伝達特性、出力特性の３つがあります。







　　　　　　　
　　　　　　　　　　　　　図3.3　トランジスタの接地方式
　3.2.2　入力特性（VBE－IB特性）
　コレクタ・エミッタ間の電圧VCEを一定に保ったときの、入力側の電圧VBEと電流IBの特性です。ダイオードの静特性と似た特性を示します。







入力特性
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入力特性シミュレーション用の回路図
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シミュレーション設定

[image: image92.emf]            V_V1

0V 200mV 400mV 600mV 800mV

IB(Q1) IB(Q1)

0A

10uA

20uA

30uA


シミュレーション結果
電流伝達特性
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電流伝達特性シミュレーション用の回路図
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シミュレーション設定
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出力特性シミュレーション用の回路図

　今回のシミュレーションでは、一般的なDC解析の設定に加えて、Parametric Sweepの設定を行ないます。下の図のようにParametric Sweepを設定するとI１の電流値を、0μAから50μAまで10μAずつ増加させながら、６個のDC解析を一回に行なってくれます。
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シミュレーション設定

　Parametric Sweepの設定を行なった場合、シミュレーションが終了すると下のようなウインドウが表示されるので[OK]ボタンをクリックします。
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パラメトリック解析終了後に表示されるダイアログボックス

[image: image100.emf]            V_V1

0V 1.0V 2.0V 3.0V 4.0V 5.0V

IC(Q1)

0A

1.0mA

2.0mA

3.0mA

4.0mA

5.0mA


シミュレーション結果
基本的なエミッタ接地増幅回路
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シミュレーション結果

エミッタ接地増幅回路
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